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- Ateam of design professionals including multimedia instructors,
students, authors, and editors worked together to create this series.

- The Web Collection Revealed Premium Edition is the first book on
the market to feature Adobe Dreamweaver, Adobe Flash, and Adobe
Photoshop all together in the same text:

- Full-color illustrations and a user-friendly design combine to create a
solid learning experience that reveals how to master the latest
features of these popular applications.

- Students gain practical experience with the software as they work
through end-of-chapter projects and step-by-step tutorials.

- An integration chapter demonstrates how to move from one
application to the other while creating a Dreamweaver website that
iIncorporates both Flash and Photoshop files.
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Features

Before jumping into
Instructions, in-depth
comprehensive conceptual
information tells students “why”
skills are applied.

This book provides the “how”
and “why” through the use of
professional examples.

Also included in the text are
tips and sidebars to help
students work more efficiently
and creatively, or to teach a bit
about the history or design
philosophy behind the skill they
are using.
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CHAPTER

GETTING STARTED WITH

ADOBE PHOTOSHOP CS5

Using Photoshop
Adobe Photoshop C55 is an image-editing
jprogram that lets you create and modify

digital images. 'CS’ stands for Creative Suite,

a complete design environment. Although
Adobe makes Photoshop available asa
stand-alone product. it also comes bundled
with all of their Creative Suite options,

whether your interests lie with print design.

web design, or multimedia production.

A digital Image is a picture in electronic
form. Using Photoshop, you can create
woriginal artwork, manipulate color images,
and retouch photographs. In addition to
being a robust application popular with
graphics professionals, Photoshop is
[practical for anyone who wants to enhance

existing artwork or create new masterplieces.

For example, you can repair and restore
damaged areas within an image, combine

images, and create graphics and special
«ffects for the web.

| auiek rip

Understanding Platform User
Interfaces

Photoshop is available for both Windows
and Macintosh platforms. Regardless

of which platform you use, the features

and commands are very simnilar. Some of
the Windows and Macintosh keyboard
commands differ in name, but they have
equivalent functions, For example, the [Crr]
and [Al] keys are used in Windows, and the
|#¢| and [option] keys are used on Macintosh
computters. There are also visual differences
between the Windows and Macintosh
versions of Photoshop due to the wser
interface differences found in each platform.

Understanding Sources

Photoshop allows you to work with images
from a variety of sources. You can create
your own original artwork in Photoshop,
use Images downloaded from the web,

or use images that have been scanned or
created using a digital camera. Whether you

create Photoshop images to print in high

|nmmamnmmumnmue.
document, gaphi, pliue, of mage.

PROTOSHOP 1-2

resolution or optimize them for multimedia
presentations, web-based functions, or

animation projects, Photoshop is a powerful
toal for icating your ideas visually,
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Tools You'll Use
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- Each chapter
begins with a
visual overview
of the Tools
You'll Use In the
chapter.
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What You’'ll Do

- Each lesson starts
with a What You’'ll Do (...
figure. This figure
gives students an at-
a-glance look at what’s
to come in the chapter
and a detailed
description of the
following lesson.

Learn How to Open
AND SAVE AN IMAGE

Opening and Saving Files saved as a bitmap (.bmmp) file, and then save it
Photoshop provides several options for asa JPEG (jpp) file to use on a web page.
opening and saving a file. Often, the project e .

youute working on deterrmines the techniques Customizing How You Open Files

you use for opening and saving files. For You can customize how you open your files
example, you might want to preserve the by setting preferences. Preferences are options
original version of a file while you modify youcan set that are based on your work habits.
4 copy. You can open a file, and then For example, you can use the Open Recent
immediately save it with a different filename, as command on the File menu to instantly
well as open and save files in many different file Ipcate and open the files that you recently
formats. When working with graphic images, worked on, or you can allow others to preview
your files as thumbnails. Figure 3 shows the

you can open a Photoshop file that has been
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Open a file using the Application bar

1. Click File on the Application bar, then dlick Open.

o

. Click the Lookin st arrow (Win) or the Current
filk location list arrow (Mac), then navigateto
the drive and folder where you store your Data iles.

. Click PS1-1.psd, as showm in Figure7, then
dlick Open.

o

open e

Open a file using the Folders panel
in Adobe Bridge

1. Click the Launch Bridge button & onthe
Application bar, then click the Folders panel
tab if the Folders panel is not active.

2. Navigate through the hierarchical tree to the
drive and folder where you store your Chapter 1
Data Files, then click the Essentials workspace
ifitis not already selected.

3. Drag the slider (at the bottom of the Bridge
window) a third of the way between the
Smaller thumbnall size button CJand the
Larger thumbnail size button []. Compare
your screen to Figure 8.

4. Double-dickthe image of a butterfly
(PS 1-L.). Bridge Is nolonger visible.

£. Click the Close button in the butterfly image
in Photoshop.

open o fike This fture makes it easy to see which fle you
want o2,

PHOTOSHOP 1-12
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Figure 7 Cpendivkyg bax for Windows and Macintosh

folders and
files may
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Jour it

Lookin st amw displays
list o vt drives

Figure 8 Adobe Bridge window
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Getting Started with Adobe Photoshop CS5
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Lesson 2 Learn How to (ipen and Save an frage
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Open a file using Mini Bridge
1. Qickthe Launch Mini Bridge button fe
‘on the Application bar, the click the Browse
Files button if necessary.
TiP Yo Mini
esize it by dragging any ﬂinwirhm!i!
bottom-right comer.
Clickthe Panel View button [, and
make sure only the Pathbaris selected.
3. Use the Path bar tolocate the drive and folder where
‘you store your Chapter 1 Data Files. See Aqure 9.
4. Double-dlick the image of a butterfiy (PS 1-21if).
5. Close Mini Bridge, then dose PS5 1-2.Hf
Vow opened M Bridge in Photoshap, navigated to where yoor
Dirta Files are stoved, opened e fit, then closed Min Bridge.

]

Use the Save s command

2

.« Veriry that the P5 1-1.psd window|s active,

Click File on the Application bar, click Save As,

then compare your Save As dialog boxto Figure 10.

3. Ifthedrive containing your Data Rlesis not
displayed, click the Save inlist arrow (Winor the
‘Wherelist arrow {Mac), then navigate to the drive
‘and folderwhere you store your Chaptes 1 Data Fles.

4. Select the current filename in the File name

et boo (Win) or Save As text box [Mac), type

Playground, then dlick Save.

TIP Cick 0K to dose the Maximize Compatibility dialog
b ift appears now andinfuturelessons.

b

Py The i

whife keeping the t

PHOTOSHOR 1-13

Conceptual Lessons walk students through each process,
step-by-step with detailed images, icons, tips and notes.
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SKILLS REVIEW

SKILLS REFERENCE

Start Adobe Photoshop (S5. Learn about design principles and 3. Name thee differences between print and
1. Start Photoshop copyright rules. webdesign. ) ;
POWER USER SHORTCUTS 2. Createa new image that is 510600 pivels acceptthe 1 your contiof? 4 “ﬂde_"':“w"dmmﬂﬂin image not be used in
defauftresalution, then name andsave it = Review. 2 How can a page be balanced? a project]

T de this: Us & this method: To do this: Use this method:
Open and save an image,
Oesea file [Ctrl][\'l'] {Win) Open Prefierences dialog box [Ctel][K] (Win) 1. Dpen PS 1-3.jpq fiom the drive and folder where you Figure 27 Complete Skills Revizw
"f [W] (Mac |31 [K] {Mac) store your Data Files
hera 2. Saveitas Rafting. (Use the default options when
Cremto a new file [[M][N] (Wi} Reset proferencesto default settings M][IR][EI!I] m sawing the file using a new name.)
| [H] (Mae) [shift][option] > (Mac) Examine the Photoshop window. e
Crete a workspace Window > Workspace 3 New Saveafile [l (in) 5 :':J:;:E:"hwamh‘ M L
Worlspace "H (5] Mag) 1. Locate the menu you wse to open an image. :
y 3. ViewtheTools the optians bar, and th ls L
it Phtoshop e Show i st [t el abe wci
'f N Im 4, Click the Move toof an the Tools panel, view the ln.
: = Move tool the options bar, then reset thy &,
Lassotool & orl Show or hide all open panek [hift][Tab] &?:mlsr:;:a:. e e &
o = = 5. Create, save and display a customized workspace &,
Launch Bridge = Show or hideall open panek, the [Tak] based on Esentials called History and Layers .
mﬂlﬁhﬂ “1hﬁﬁﬂ that capture; panel locations and displays the History )""
Launch Mini Brdge - Showor hide Swatces panel Window > Swatches ot e i
. Playground.psd. g
Fp i [E:‘I][ﬂ] ikl sl :%m[gl}iuﬂ tm& Close a file and exit Photoshop. l&
E M Im Laf [i ][5] m 1. Compare yourscreen to Figure 27, then close the -
Rating . -
Key: Menu ftems are inafcated by > between the menu name and its command. Blve bold letters are shortcuts for 2. Close the Reviewfle, £
selerting tools on the Tools panel 3. Exit (Win) or Quit (Mac) Photoshop.

Skills Reference table highlights power user shortcuts to tools used in the chapter

Skills Review exercises are included at the end of each chapter and contain hands-on
practice exercises that mirror the progressive nature of the lesson material.
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PROJECT BUILDER 2

PROJECT BUILDER 1

At some point in your working with Figure 29 Sample Project Buider 2

Photoshop, you'll probably have direct | csnin G R e e il o
contact with one or more clients. Rather F
than take a sink-or-swim approach when
this inevitable time comes, you decide to

As anew Photoshop user, it's nice to know
that there are so many tools to help you

Figure 28 Somple Project Budder |

perform a task. Bridge and Mini Bridge seem is
to have many of the same features, yet Mini S Bk bopos Ees AR aE U e D s eREc
Bridge is available from within Photoshop - a — SiEgTsEs.
riﬂgve stand- & 1. Open your favorite browser and szardh engine and
ﬁf b aj;; = ﬂhﬁﬁm:m m = find a website with relevant information abaut How To Communicate Design Decisions

communicating with design clients.
2. Keep track of the most relevant website and make
notes of key paints on the information you've found.

To Clients?

determine the best usage for each. =t i o

1. Open Photoshop, open Mini Bridge, then open Bridge.
2. Examine the folder containing the Cata Rles for this
chapter and be prepared to disquss the differences e
between Bridge and Mini Bridge.
3. Whatare the sorting and printing limitatiors of
Mini Bridge versus Bridge? Mini Bridge is shown
in Figure 28.
4, Be prepared to discuss the best usages of Bridge and
Mini Eridge.

A sample website & shown in Figure 29,
. Be prepared to discuss how you'll effectively interact
with your design clients when the time comes.

Courtesy of Smashing Magzine

Two Project Builder exercises are featured at the end of
each chapter . These exercises require students to apply the
skills learned in the chapter. A finished example of the project
IS included.
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- The end-of-chapter -
Design Project
tests the student’s  [uimecss - ===

want to make sure you fully understand the
differences between designing for print and
designing for the web, so you decide to use

ability to design a S

1. Connect tothe Internet, and use your brawser ta find
#t least two websites that have information about the

- - - differences between print and web design principles.
I e Ce O I n I S e 2. Findand download one image that servesasan
p example of good print design and ane image of
good web design. Save the images {in jpg format) as
work.

Print design-1and Web design-1. Figure 30 shows a
sample of web design.

— Student’s are
encouraged to take
artistic license in
creating their work.
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- Portfolio Projects
differ from other
projects and lessons
In the text.

. Strategies and
methods for
achieving the
finished product are
suggested rather
than following a
step-by-step
approach.

~ + CENGAGE
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You are preparing to work on a series of
design projects to enhance your portfolio.
You decide to see what information on
dipital imaging is available on the Adobe
wehsite. You also want to increase your
familiarity with the Adobe website so
that you can take advantage of product
information and support, user tips and
feedback, and become a more skilled
Photoshop user. Youd also like to become
muore familiar with the concepts of

intellectual property and copyright issues.

1. Connecttothe Intemet and go to the Adobe website
at wiwwadobe.com.

2. Point to Products, then find the link for the
Photoshop family, as shown in Figure 31.

3. Use the links on the web page ta search for
information about digital imaging options.

4. Print the relevant page(s).

5. Use your favorite browser and seardy engine to
find several sites about intellectual propertyand
copyright issues.

6. Printat leasttwa of the sites you find the
most interesting

7. Baluate the information in the documents, then

compare any significant differences.

PORTFOLIO PROJECT

Figure 31 Somple Fortolio Project
5 -
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Extensive data files—including HTML files, text, images,
Flash content, and video content—are included with the
text to engage students and give them the tools they need
to develop a Web site from start to finish.

THE WEB —
coLLecTion i
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An Instructor Resource CD
available with this book
includes:

INSTRUCTOR
RESOURCES

- Instructor’'s Manual
— Chapter overviews
— Detailed lecture topics
— Teaching tips
- PowerPoint presentations
. Solutions to exercises
- Test banks

- ExamView test generator
and testbank

- eBook available

e

PREMIUM EDITION

. |
THE WEB
DREAMWEAVER CS5
COLLECTION
PHOTOSHOP CS5

SHERRY BISHOP, JIM SHUMAN & ELIZABETH EISNER REDING
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The Web Collection Revealed Premium Edition: Adobe Dreamweaver CS5, Flash
CS5 and Photoshop CS5, 1st Edition

v hg A

The Web Collection Revealed Premium Edition: Adobe

Dreamweaver CS5, Flash CS5 and Photoshop CS5, This interactive site offers a number of password-
Book Resources 1st Edition

protected resources that will enhance your
teaching. For yvour convenience, we have also
Sherry Bishop, Jim Shuman, displayed the resources your students can use to
Barbara M. Waxer test themselves, research, or review.
ISBN-10: 1111130752
ISBN-13: 9781111130756
= 2011

@ Instructor Manual
B Lecture Slides

@ Solution Files

& syllabus

i TestBanks

Le=arm meore about this product

€ indicates Instructor Resource,
Username and Password required.
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